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Abstract

Various studies have demonstrated the usefulness of adsorption of activated carbon on
VOCs removal. Large porosity and high adsorption allows activated carbon to remove very
small particles. This project was commissioned by the company name Genano Oy to test
the activated carbon filter in their air purifier and hence to provide a database for the com-
pany. The purpose of this thesis was to study the effectiveness of impregnated activated
carbon filter on toluene removal.

Experiment was conducted with a pipe model consisting activated carbon filters to simulate
a ventilation system. Two batches of activated carbon were used, and one to three layers
of filters containing these activated carbon were made. Toluene was prepared at low con-
centration. The samples before and after contacting the activated carbon filter inside the
pipe model were taken by tenax tubes. At last, the results were analyzed by using a ther-
mal desorber gas chromatography mass selective detector.

The results of this thesis indicate that filters with one layer of impregnated activated carbon
had a removal efficiency around 40 %. Based on these results, impregnated activated car-
bon revealed their potential on VOCs removal.

Keywords Toluene, activated carbon, adsorption, tenax tube, TD-
GCMSD, indoor air quality.
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GC Gas chromatography
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TD-GCMSD Thermal desorber gas chromatography mass selective detector
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1 Introduction

Serious consideration toward environmental impacts and attempts to address them
have developed significantly in recent decades. Among these issues, air pollution
stands out as one of the principle concerns as it had drawn attention already after the
industrial revolution. Air pollution resulted in anthropogenic emissions includes industri-
al manufacturing, domestic utility, and transportation. From these, common pollutants
such as carbon monoxide (CO), sulfur oxides (SOy), nitrogen oxide (NOy), volatile or-
ganic compounds (VOCs), ammonia (NHs), and particulates (PM) are discharged
(Cooper and Alley, 2011). Air pollution contributes to human health problems, ecosys-
tem threats, climate change, acidification, ozone depletion, haze and smog formation,
and eutrophication. Of major believes, air pollution is highly related to lung cancers and
other diseases. As reported from World Health Organization (WHO, 2014), around 7
million people died worldwide in 2012 as a result of air pollution.

Air pollution could be outdoor or indoor pollution where the term outdoor pollution often
refers to the urban air quality. Both urban and indoor air quality are described as the
worst pollution problems especially in developing countries in Asia. Meanwhile, regula-
tions and treatments have been carried out to reduce emissions, for example, from
factories to the atmosphere. Building ventilation and indoor air purifiers have been in-
stalled to improve indoor air quality (IAQ).

As people move into the city and spend more time indoor especially in developed coun-
tries, for instance, working or visiting in offices, factories, stores, restaurants, hotels
and airports, staying at homes, and traveling inside vehicles, the effect of indoor air
pollution is tremendous on human health (Cooper and Alley, 2011, pp.695). Regarding
indoor air pollutants, which often contain irritation or even toxic and hazardous sub-
stances and hence decline the indoor air quality and threat occupant’s heath, volatile
organic compounds (VOCSs) are recognized as one of the major contributors along with
other pollutants including CO, radon, particulates, and microbial contaminants such as
mould. According to the study from U.S.EPA (EPA, 2015a), VOCs concentration tends
to be much higher indoors than outdoors. As a result, proper building ventilation and air

purification methods especially for treating VOCs is required to secure human health.
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Toluene, a very common indoor air pollutant and model compound for VOCs, is the
focus of this study. Toluene can be found as a solvent in many commercial products
such as paints. In recent research, major approaches attempt to remove toluene in-
clude adsorption, thermal incineration and catalytic oxidation. For example, a study
conducted by Liu, Chen and Peng (2013) has shown that adsorption method on acti-
vated carbon filters has drawn great deal of attention recently due to the characteristics
of having a much larger specific surface area, faster adsorption, high fluid permeability,
and a more uniform micropore structure. Hameed (2009) also described adsorption
method as “the most efficient, promising and widely used fundamental approach” due
to its “simplicity, economical viable, technically feasible and socially acceptable”. For
these reasons, this study chose the adsorption method on activated carbon filters for

toluene removal.

This thesis consists of an introduction, theoretical background, and an experimental
part where the experiment using a thermal desorber gas chromatograph mass selec-
tive detector (TD-GCMSD) and tenax tubes on analysing toluene removal by activated
carbon filters is described. Results of the experiment are presented and discussed and
conclusions are drawn at the end of the thesis.
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2 Goal and scope

This thesis was made for a company, Genano Oy (Genano) who is professional in air
purification technology in buildings such as hospitals and laboratories. Genano pro-
vides services on air purification using technology including electrostatic precipitation
where activated carbon filters perform as a part of the components in those devices.
This project work was conducted during my internship with Genano using Helsinki
Metropolia UAS facilities. The results of this thesis would be used to provide a data

base and to support decision making for Genano.

The purpose of this thesis was to study the behaviour of activated carbon filter and the
quality of different batches of impregnated activated carbon filters (provided by
Genano) on indoor gas pollutant of toluene removal. An designed experiment was con-
ducted to create a model of an indoor ventilation system with PVC pipes containing an
activated carbon filter while fed with toluene gas. Air samples were taken by using
tenax tubes and were later analysed with TD-GCMSD.

The thesis focused on homes and commercial buildings where the system is modeled
to keep the toluene concentration low for analysis. The activated carbon used in the

experiment was not necessary provided from Genano.
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3 Theoretical background

3.1 Indoor air

Studies have shown that average person spent his/her day 86% indoor while 8% out-
door and 6% traveling in United States. In other word, people spend around 20 hours
indoors per day. As a result, the quality of indoor air in residences and public buildings
generates a significant concern at personal level. (Griffin, 2007, pp.291) IAQ is intro-
duced as it refers to the air quality in a building especially relating to the occupants’
health and comfort. Unpleasant air odor inside a room is also an example of IAQ con-

cern.

Indoor air is treated in a different way from outdoor air due to two main reasons. The
first reason is that indoor air is considered as private property and therefore it must be
subjected to different regulations from those set for outdoor air. The second reason is
technical where the air behaves differently between indoor and outdoor due to different
pollutant sources and dispersion behaviour. In addition, the concentrations of certain
pollutants may be higher outdoors than indoors, while those of other pollutants are vice

versa. (Cooper and Alley, 2011, pp.696)

The concentrations of most indoor air pollutants tend to be higher in the winter than in
the summer. This results from people tending to close the windows for heating during
the winter and open the windows for cooling during the summer. Thus, the air ex-
change between outdoors and indoors will be greater in the summer than in the winter.
(De Nevers, 2000, pp.542-543) Apart from this, using an air conditioner in the summer
while closing the windows for cooling down the temperature also services like a closed
system. In such cases, the IAQ relies greatly on the ventilation system and also on an
air purifier if necessary. However, in most developing countries especially in China
where the ambient air quality is generally poor, it does not benefit much when exchang-

ing indoor air with outdoor air. Therefore, an air purifier is needed for the indoor space.

3.1.1 Indoor air pollutants and their sources

The six most common air pollutants identified by the Clean Air Act (CAA), also known
as the criteria pollutants, are PM, ozone (ground-level), CO, NO,, SO, and lead. (IDA-
HO, 2015) Regarding indoor air pollutants, criteria pollutants are also included along
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with radon, environmental tobacco smoke, combustion emissions which contain NOg,
CO, PM and polycyclic aromatic hydrocarbons (PAHSs), formaldehyde, pesticides, bio-
aerosols such as molds, and VOCs. Those indoor pollutants come from five catego-
rised sources which are combustion sources, building materials and furnishings, con-
sumer products, people, and outdoor air. Combustion sources include stoves (cook-
ing), kerosene heaters, and tobacco smoke. Building materials and furnishings take
account of paints, particleboard, caulks, adhesives, and carpeting. Consumer products
contain cleaning materials, waxes and polishes, pesticides, and cosmetics. Indoor air
pollutants such as VOCs contributed by people are directly from biological or metabolic
functions, and indirectly from clothing, deodorants, perfumes, etc. (Cooper and Alley,
2011, pp.696-698). In a lesser degree, outdoor air is included in these categories due
to infiltration of outdoor air including CO and ozone. (Griffin, 2007, pp.291-294; Cooper
and Alley, 2011, pp.696-698)

Even though VOCs is not classified as the criteria pollutant, it is considered as a major
primary pollutant due to its relatively low vaporization temperature and therefore gen-
erates large emissions. Noel de Nevers from the University of Utah (2000, pp.329)
claimed that “VOCs are probably the second-most widespread and diverse class of

emissions after particulates”.

3.1.2 General health effects of indoor air pollution

The health effects due to the indoor air pollution can be either acute or chronic. For
acute or immediate effects, which may take place after just a single exposure or fre-
quent exposures, people may suffer from irritation of the eyes, nose and throat, head-
aches, dizziness, and fatigue. Other more serious symptoms from these acute effects
include asthma, humidifier fever, and pneumonitis. Fortunately, most of these immedi-
ate effects usually last in a short time. Treatment for such immediate effects includes
simply staying away from exposing to those pollution sources or eliminating the
sources of pollution, if it can be identified. For chronic effects, usually caused by long-
term exposure, people may suffer from respiratory diseases including emphysema,
heart diseases, and cancers. These health effects could be fatal. Apart from the expo-
sure frequency, the likelihood of both acute and chronic effects also depends on each
person. Some people are more sensitive to certain type of pollutants while others may
not. (Burke, Singh and Theodore, 2005, pp.138)
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3.1.3 |AQ control

The approach for IAQ control is similar to other emission control where the first step is
to reduce or even eliminate the use of energy in a household or public buildings includ-
ing heating, ventilation, and air conditioning (HVAC) and other appliances. According to
Energy Information Administration (EIA) (EIA 2012, p 3), this energy consumption ac-
counted for around 40% of the total energy flow in U.S in 2011. Using a better energy
efficient design of the residents and public buildings will conserve energy and thus re-

duce the emissions.

According to the U.S. EPA (EPA, 1997), “controlling indoor air quality involves inte-
grating three main strategies. First, manage the sources of pollutants either by remov-
ing them from the building or isolating them from people through physical barriers, air
pressure relationships, or by controlling the timing of their use. Second, dilute pollu-
tants and remove them from the building through ventilation. Third, use filtration to

clean the air of pollutants.”

Ventilation is the process of air exchange where outdoor air replaces indoor air that is
being exhausted to the outdoor. Air exchange occurs in building by the means of forced
ventilation, natural ventilation, and infiltration. Using fans or blowers to exchange the air
forcibly is defined as forced ventilation. Natural ventilation involves allowing ambient air
exchange simply through open windows or doors. Infiltration refers to the occurrence of
air exchange through leakage from gaps of a building while windows and doors are
closed. (Cooper and Alley, 2011, pp.704-706) To conclude, opening windows or doors

frequently in permitted conditions improves IAQ significantly.

The use of filtration refers to air purifiers or air cleaners. There are many types and
sizes of air purifiers commercially ranging from inexpensive portable models to expen-
sive whole-house systems. The performance of an air purifier depends on how much
air can be draw through the purifier and how well the purifier collects indoor air pollu-
tants. However, an air purifier could be ineffective if the source of the pollutants is too
strong. (Burke, Singh and Theodore, 2005, pp.151-154)

When dealing with VOCs, the emission control could be carried out by the methods of
condensation, absorption (scrubbing), adsorption, and oxidation. (De Nevers, 2000,
pp.329-381)
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3.2 Toluene

Toluene is a common indoor air pollutant in the group of VOCs. It is the main focus of
this study. The molecular formula of it is CsHs. The IUPAC name for toluene is
methylbenzene. Toluene is a hydrocarbon consisting of a single benzene ring (phenyl
group) and a methyl group (CHs) and is classified as an aryl (aromatic) hydrocarbon as

shown in Figure 1.

CH,

Figure 1. Structure of toluene.

Toluene behaves similarly to the other aryl hydrocarbons, which are widely used as
solvents in industry and served as raw materials for manufacturing plasticizers and
monomers and in polymers (Manahan, 2000, pp.360). Therefore, toluene was used as
a model compound for the VOC removal in this thesis.

3.2.1 Basic properties

Some basic properties of toluene are listed in the Table 1 below.

Table 1. Physical properties of toluene (Sigma-Aldrich).

Toluene (CAS-No. 108-88-3)

molar mass: 92.14 g/mol

density: 0.865 g/mL (at 25 °C)

form in nature: liquid

color: colorless, transparent

odor: aromatic, sweet, pungent

melting point: -93 °C
—‘
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boiling point: 111 °C
vapor pressure: 29.1 hPA at 20 °C
water solubility: 0.5g/Lat15°C

These data were collected by using material safety data sheet (MSDS) from Sigma-

Aldrich Company.

3.2.2 Source of toluene pollutant

As an example of VOCs, toluene shares similar sources with other VOCs, which in-
clude “paints, thinners, perfumes, hair sprays, furniture polish, cleaning solvents, carpet
dyes, glues, dry cleaned clothing, air fresheners, candles, soaps, bath oils, molds, to-
bacco smoke” (Cooper and Alley, 2011, pp.698). Regarding tobacco smoke, 1,260 ug
toluene is produced from smoking one cigarette (Griffin, 2007, pp.296).

3.2.3 Health effect of toluene

According to the MSDS (Sigma-Aldrich) in Appendix A, toluene is not considered as a
hazardous but only dangerous chemical. However, it is necessary to take into account
its properties including flammability when conducting experiment. Precaution must be

taken and exposing toluene to high temperature must be avoided.

Toluene is also classified as one of the indoor air pollutants due to its occurrence from
many of the normal household materials. Toluene smells unpleasant which is similar to
the smell of super glue. Contacting toluene at low level in short time will only irritate
noise and throat. Reports (CCOHS, 2015) have shown that inhalation of toluene at low
level in longer period may cause tiredness, weakness, dizziness, drunken-type actions,
and even loss in hearing, color vision, and memories. Fortunately, these symptoms are
classified as chronic effects which disappears immediately when exposure is stopped.
CCOHS (2015) also stated that inhaling toluene at high level in short time can cause
nausea, sleepiness, and unconsciousness. In addition, inhaling toluene at high levels
for a longer period can cause serious health effects. Research testing with Long-Evans
rats (Kodavanti P. et al, 2015) shown brain and neuro damages and degenerative ef-

fects due to the toxicity of inhaling toluene.
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3.3 Adsorption

The removal of gases and vapors typically at low concentrations at the end point of the
exhaust stream can utilize the application of adsorption. Adsorption is defined as the
phenomenon when molecules of a fluid or dissolved solid attach, or adhere to the sur-
face of a collecting medium (usually solid). The material cause adsorption is called the
adsorbent and the fluid being adsorbed is known as the adsorbate. The Adsorber, or
the adsorption system, works on the principle of molecular or atomic interaction at its
surface. It is different from absorption where the absorbed materials are dissolved into
the absorbent while adsorbed materials are only attached onto the adsorbent surface.
(De Nevers, 2000, pp.354; Wang, Pereira and Hung, 2004, pp.395) The term desorp-
tion is the reverse process of adsorption. The application of adsorption is usually deal-
ing with gas phase air pollution and is usually carried out at a low vapor pressure. This
thesis is mainly focused on the activated carbon and toluene as the adsorbent and ad-

sorbate.

3.3.1 Adsorption theory

Adsorption can actually occur at the surfaces of any solids. However such adsorption is
very small unless the solid is highly porous and has the structure like fine capillaries. In
other word, the internal surface area, or the surface-to-volume ratio refers to the ability
of adsorption for a solid material. The larger the internal surface area of an adsorbent,
the higher the efficiency on adsorbing the adsorbates.

According to Wang, Pereira and Hung (2004, pp395-396), adsorption can take place in
several specific means. It can be used effectively for separating gases from gases,
solids from liquid, dissolved gases from liquid, and ions from liquid. He continue ex-
plained that during the process of adsorption, it involves three steps of contact, separa-
tion, and regeneration. When a fluid passes through an adsorbent, it is firstly adsorbed
at the surface of the adsorbent as they get contacted. At this point, the composition of
the fluid will change where one or more of its components are adsorbed. Then followed
by the separation where the unadsorbed components pass through the absorbent and
leave the adsorbates on the surface of the adsorbent. In the final step of regeneration,
or desorption process, the adsorbates are removed from the adsorbent and collected
somewhere else. In other word, regeneration is the cleaning process for the adsorbent.

This can be done by applying heat to remove the adsorbates.
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In the case of this work, it is interested in studying the adsorption for separating vapor-
ized toluene from the normal indoor air using activated carbon filter. And the step of
regeneration is carried out by using a thermal desorber (TD) at elevated temperature to
clean the tenax tube which will be discussed in the later methodology section.

3.3.2 Physical and chemical adsorption

Theodore (2008, ppl186-187) explained that adsorption mechanism is distinguished by
physical and chemical adsorption due to the different manner of bonding between ad-
sorbate and adsorbent. The processes of both adsorptions are considered to be exo-
thermic as the gas molecules lose their kinetic energy when attached to the adsorbent
in the form of heat. In the case of this work, activated carbon filter is used as a physical
adsorption application.

Removing VOCs by using activated carbon adsorbent is an example of physical ad-
sorption, also known as van der Waals adsorption. It involves a weak bonding of ad-
sorbate (gas molecules) to the adsorbent (solid) resulted from the intermolecular cohe-
sion. This weak bonding is akin to the attraction forces between two molecules in a
liquid. The chemical nature of the adsorbed fluid remains unchanged in physical ad-
sorption. As a result, it is a readily reversible process. Applying heat or reducing the
pressure can break the forces holding the gas molecules to the solid in physical ad-
sorption. Therefore, heating or reducing the pressure in the adsorbers can be used to
regenerate or to clean the adsorbents. (Cooper and Alley, 2011, pp387; Theodore,
2008, ppl186-187) The enthalpy changes in physical adsorption are small that the typi-
cal range is between 10 and 40 kJ/mol (Thomas and Thomas, 1997, pp65).

Physical adsorption can be also described by the polarity of the molecules of the fluid
adsorbate and solid adsorbent. According to the chemical structure, molecules can be
either polar or nonpolar. The polarity of the molecules of the solid adsorbent surface
determines the type of fluid adsorbate it can adsorb most likely. Polar adsorbents ad-
sorb polar adsorbates and nonpolar adsorbents adsorb nonpolar adsorbates. For ex-
ample, activated carbon is generally a nonpolar adsorbent, thus, it is used to adsorb
nonpolar adsorbates such as most of the organic compounds. Besides, polar adsor-

bents are used preferentially adsorb water vapor for instance. However, in certain situ-

y =
e ——

/ Meétropolia

University of Applied Sciences



11

ation, activated carbon can be also applicable when dealing with polar adsorbates.
(Theodore, 2008, ppl186-187)

Chemical adsorption, or chemisorption, involves chemical bonding (similar to covalent
bonding) from the reaction within the adsorbate and adsorbent where the electrons are
being rearranged. Examples include the oxidation of SO2 to SO3 on activated carbon
which involves chemical reactions (Cooper and Alley, 2011, pp387). Such bonding is
much stronger than physical adsorption and is not easily reversible (Theodore, 2008,
ppl86). The heat of chemisorption is usually larger than physical adsorption which of-
ten exceed 400 kJ/mol (Thomas and Thomas, 1997, pp65).

3.3.3 Pore size distribution

Several physical properties indicate the adsorption behavior of an adsorbent. Accord-
ing to Theodore (2008, pp188-190), these properties includes the surface area, internal
porosity, pore volume, mean pore diameter, and bulk density. It is generally described
that the larger the surface area the better the adsorption effectiveness. However, it
should be noted that the effectiveness of adsorption is also determined by adsorbent
pore size. If the pore size is not suitable, the adsorption works poorly no matter how
large the surface area is. Theodore stated that “the surface area must be available in

certain pore sizes if it is to be effective as a vapor adsorber”.

To explain the pores characteristic begins with understanding their size range. Accord-
ing to the sizes of pores, they are classified into micropores, transition pores and
macropores. Pores having diameters of 400 nm or less are micropores and larger than
4000 nm are marcopores. Transition pores are those in between this range. (Theodore,
2008, pp188)

Adsorption works the best if the pore size of the adsorbent is relatively similar to the
size or the adsorbates or gaseous molecules. When the pore size of the adsorbent is
smaller than the size of adsorbate, the adsorbate is unable to reach these surfaces. As
a result, these pores cannot adsorb the adsorbates. Moreover, the larger pores
(macropores) capture adsorbates with size much smaller than themselves inadequate-
ly. This is resulted from that these larger pores serve simply like a passageway to the
areas with smaller pores for adsorbates. (Theodore, 2008, pp188) Therefore, the effi-

ciency of activated carbon adsorption depends on its surface accessibility. Figure 2
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below illustrates the distribution and behavior of different pore sizes in typical activated

carbon adsorbent.

Macropore

Molecule
— blocking pore

Area unavailable

Yot L [~ for adsorption

Figure 2. Pore size distribution of activated carbon (Theodore, 2008, pp189).

As described, typical air pollutant adsorbates are much smaller than macropores,
therefore these molecules are unlikely to be adsorbed on the surface of macropores
and will continue travel toward smaller pores. In the meantime, large molecules will be
blocked at the area before entering small micropores. To be more exact, Theodore
(2008, pp189) also claimed that “adsorption forces are strongest in pores whose sizes

are not more than roughly twice the size of the adsorbate”

3.3.4 Regenerable and nonregenerable adsorption system

Adsorption system can be either regenerable or nonregenerable. Regenerable means
that the adsorbent can be used several times after regeneration process. Nonregener-
able system refers to those serves like a disposable adsorbent. In general, regenerable
adsorption system is used to treat contaminates at higher concentration in cases like
industrial emissions. There is usually two adsorption beds in regenerable system.
When one of the bed is consumed, the adsorbates are redirected to the second bed.
The consumed bed is then desorbed as described in previous section and become

ready to use later. Such system allows the adsorption beds to function automatedly
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and sustainably. A nonregenerable system does not require the process of desorption.
Adsorbents in such system are simply replaced, usually manually, by another new one
once it is consumed up. Nonregenerable systems are typically used for removal of con-
taminates at very low concentration in unit of parts per million (ppm). The used adsor-
bent beds are then sent back to the manufacturer for recovery. (Theodore, 2008,
ppl190-194)

Regarding this work, activated carbon filter functioned as a nonregenerable adsorption
system. After several experiment test, those filters were replaced manually by new
ones. These activated carbon filters used during the experiment of this thesis were not

necessary provided from Genano.

3.3.5 Adsorbent

Adsorbents are typically composed of either natural or synthetic materials allowing
them to have a microstructure where the surfaces of the internal pore are accessible to
the gas phase pollutants (Griffin, 2007, ppl64). Adsorbents exist on the market are
available in great variety. Most common adsorbent material used is activated carbon
which can be used in various applications. Other adsorbent materials include alumina,
silica gels, and bauxite. And these adsorbents are usually regenerable and can be
used several times in the adsorbers. (Cooper and Alley, 2011, pp392; Griffin, 2007,

ppl64) Some general utilities of these adsorbents are described below in Table 2.

Table 2. General functions of some common adsorbents (Wang, Pereira and Hung, 2004, pp396).

Adsorbent Utility

Activated carbon solvent recovery, elimination of odors, purification of gases
Alumina drying of gases, air, and liquids

Silica gel drying and purification of gases

Bauxite treatment of petroleum fractions, drying of gases and liquids

Regarding indoor air purification, alumina, silica gel, and bauxite are less likely to be
used in the adsorbers. The application of this study is to use activated carbon as the
adsorbent to eliminate bad odor and purify the air from toluene gas existing in indoor

environment.
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3.4 Activated carbon filter

Activated carbon, also known as activated charcoal, is a form of carbon used as an
adsorption material. Activated carbon has very large surface area due to its high de-
gree of microporosity inside a small volume. According to Cooper and Alley (2011,
pp392), the term “activated” regarding adsorbent refers to “the increased internal and
external surface area imparted by special treatment process”. Such treatment is done
by applying heat in the form of steam, air, or carbon dioxide where these gases violate

the carbon and cause it to increase its pore structure.

Adsorption of activated carbon is an example of physical adsorption. As described pre-
viously, activated carbon’s nonpolar surface is useful on controlling emission of nonpo-
lar organic solvents, VOCs and gasoline vapors. In practice, it can be also used to re-

move unpleasant odors especially from indoor.

Activated carbon is prepared and packed in different forms according to each purposes
and work basically like a filter to remove contaminates in the air. It works on the princi-
ple where activated carbon remove contaminants from liquid or vapor streams such as

VOC:s for the approach in this study.

3.4.1 Physical properties

As explained in the previous section, several physical properties effect the behavior of
adsorbent. These properties for activated carbon are listed in the Table 3 below.

Table 3. Physical properties of activated carbon (Theodore, 2008, pp189).

Adsorbent | Surface area | Internal Pore volume | Mean pore | Bulk density
(m2/g) porosity (cm3/g) diameter (g/cm?)
(%) (nm)
Activated
carbon 600 - 1600 55-75 0.80-1.20 150 - 200 0.35-0.50

Activated carbon adsorbents have pore size between 150 and 200 nm which is suitable
for application as micorpores. As described earlier, Theodore (2008, pp189) claimed
that adsorption forces perform most efficiently when the size of adsorbent pore is
around doubled of the size of adsorbate. In addition, most gaseous molecules from air
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pollutants, including VOCs, are having diameters in the range of 80-180 nm. Also,
nearly 95% of activated carbon pores are micropores. Therefore, activated carbon can
remove most VOCs adequately. (Theodore, 2008, pp189-190)

3.4.2 Types of activated carbon

Activated carbon can be made from carbonizing various raw materials such as coal,
petroleum-based products, wood, coconut, and nutshells. Carbonization is the process
of heating the material to an elevated temperature (usually 600 °C) to drive away all
volatile material leaving desired carbon behind. (Theodore, 2008, ppl87) Activated
carbon made from different raw material and carbonizing method will behaves different-
ly. According to different interest and purposes from manufactures, the parameters
producing activated carbon vary. Based on the preparation methods, size, and applica-
tions, typical types of activated carbons include powdered, granular, extruded, and im-
pregnated activated carbons. Impregnated activated carbon (IAC) is the type of carbon
used in this study and will be described in the later section.

Powdered activated carbon (PAC), as its name, it is the carbon that being crushed or
grinded into fine particles like sand dust. PAC is made from organic materials such as
wood, lignite and coal giving it very high carbon content. According to EPA (2015b),
PAC is typically manufactured with a diameter less than 0.1 mm. PAC has very small
particle size PAC is widely used in water treatment to adsorb contaminates, taste and
odor in the water (EPA, 2015b). Granular activated carbon (GAC) is the carbon in
granular form that looks like little rocks and has relatively larger size compared to PAC.
Raw materials used to manufacture it include bituminous coal, peat, coconut shells,
wood, and lignite. It is mainly used in water treatment process. (AWWA, 2012) Extrud-
ed activated carbon (EAC), also classified as one form of GAC, is the carbon being

extruded or compressed into cylindrical shape like pellets (AWWA, 2012).

3.4.3 Impregnated activated carbon (IAC)

“Impregnated activated carbons are carbonaceous adsorbents which have chemicals
finely distributed on their internal surface. The impregnation optimizes the existing
properties of the activated carbon giving a synergism between the chemicals and the
carbon. This facilitates the cost-effective removal of certain impurities from gas

streams.” (1JST, 2009).
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The appearance of most of IAC is similar to a sponge or foam. As a result, it is also
known as the foamed activated carbon. One oblivious difference between different
IACs, depending on their component and manufacturing procedure, is their softness.
Some IAC filters are very soft like a sponge while some are more solid.

3.4.4 Activated carbon adsorption and saturation stage

Carbon adsorption is the process which certain pollutants are adsorbed selectively at
the surface of activated carbon adsorbent. Study (Wang, Pereira and Hung, 2004,
pp396) has shown that activated carbon is one of the most effective adsorbent for re-
moving generally all the organic vapors such as VOCs, regardless of distinction in con-
centration and humidity. Wang, Pereira and Hung (2004, pp396-397) explained that
adsorption by activated carbon happens in two stages, adsorption and saturation stag-
es.

During the adsorption stage, fresh activated carbon filter adsorbs fluids effectively and
quickly in the beginning. Activated carbon adsorbent increases its weight as adsorb-
ates are adsorbed onto it. After adsorbing for a certain time, the activated carbon is no
longer fresh, it is getting saturated with adsorbates and reaches a point where the ad-
sorbing rate decreases rapidly. This point is recognized as the breakpoint. After ex-
ceeding such point, the saturation stage appears. (Wang, Pereira and Hung, 2004,
pp397)

When saturation stage is obtained, activated carbon is said to be completely saturated
with adsorbates (vapors) and stops adsorbing anymore adsorbates and ceases to in-
crease in weight. At this stage, fluid at the inflow will simply pass through the activated
carbon filter. As a result, the concentration of the selected fluid at the inlet and outlet of
the stream appears to be the same. Therefore, saturation stage is also referred as the
adsorption equilibrium for the adsorber system. The point of saturation stage is differ-
ent for each selected fluid and activated carbon at different conditions (e.g. tempera-
ture, pressure, airflow rate, etc.). Therefore, saturation value, or the point of adsorption
equilibrium for activated carbon must be determined experimentally. (Wang, Pereira
and Hung, 2004, pp396-397)
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The maximum amount of adsorbates the activated carbon can adsorb at the saturation
stage is recognized as the adsorption capacity. Adsorption capacity is defined at a giv-
en temperature and pressure. Wang, Pereira and Hung (2004, pp397) defined that “the
retention capacity of an activated carbon is expressed as the ratio of the weight of the
adsorbate retained to the weight of the carbon”.

3.4.5 Adsorption equilibrium and isotherms

To determine the behavior of adsorption system, the adsorption system must be con-
ducted under equilibrium conditions. As described earlier, adsorption equilibrium is
defined as the condition when sufficient time is applied for adsorbates contacting with
adsorbent, the amount of adsorbate molecules coming from the inflow attached to the
surface of adsorbent is equal to the amount of adsorbate molecules leaving the adsor-
bent. Adsorption equilibrium can be also referred as the saturation stage where the
adsorbent is saturated with adsorbates and can remove no more contaminates. Thus,
adsorption equilibrium is used to determine the capacity, or the maximum amount of
adsorbate molecules, or vapors that an adsorbent can hold ad a given condition includ-
ing temperature and pressure. Stated by Cooper and Alley (2011, pp387), “generally,
the capacity of an adsorbent is directly proportional to the molecular weight and in-

versely proportional to the vapor pressure of the adsorbate.”

According to Theodore (2008, pp194-195), three types of equilibrium relationship, iso-
therm, isobar, and isostere, are used to express the adsorption equilibrium. Isotherm
means at constant temperature; isobar means at constant pressure; and Isostere
means at constant amount of vapors adsorbed. Among these three methods, Theodore
claimed that isotherm is the most commonly used for describing adsorption equilibrium
data. Theodore described that “The isotherm is a plot of the adsorbent capacity vs. the
partial pressure of the adsorbate at a constant temperature.” Isotherm represents the
capacity of an adsorbent for a specific gas or vapor which is usually expressed in

weight percent as grams of adsorbate per certain grams of adsorbent.

Generalized equations are difficult to develop for predicting the behavior of adsorption
isotherm. This is due to the fact that adsorption is very complex and sensitive and the
shape of the isotherm graph varies from a curve to S-curve and other shapes depend-

ing on each adsorption system. Therefore, adsorption equilibrium must be determined
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experimentally. (Theodore, 2008, pp194-195) Figure 3 shows an example of adsorp-
tion isotherm for activated carbon.

0.35 T T T T T T T T T T T

0.30

0.25

5

0.20

0.15

Equilibrium adsorption w
1b/1b of adsorbent

0.10

0.05

0.00 | | | | | | | | | 1 |
0.000 0.002 0.004 0.006 0.008 0.010 0.012

Partial pressure of toluene, atm

Figure 3. Adsorption isotherm for toluene on activated carbon (De Nevers, 2000, pp358).

In addition, there are several existing mathematical equations or models designed to
express the adsorption equilibrium and each of them are used specifically in different
cases. According to Cooper and Alley (2011, pp387-389), Langmuir model would be
one of the best model for describing isotherm. Foo and Hameed (2009) described
Langmuir isotherm model as a model developed for gas to solid phase adsorption onto
activated carbon. They explained that Langmuir model deals with “homogeneous ad-
sorption which each molecule possess constant enthalpies and sorption activation en-
ergy with no transmigration of the adsorbate in the plane of the surface”. Langmuir iso-

therm equation is written as below.

k1B,

w=—7F_
kyP, + 1

(Cooper and Alley, 2011, pp389) (D

where P, is the adsorbate’s partial pressure. W is equilibrium adsorptivity, mass of ad-

sorbate adsorbed per unit mass of adsorbent. And k; and k. are coefficient constants.
rs
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When the adsorbate partial pressure is very low, the value of K;P, is approximately
equal to zero, and then Eq. (1) could be rewrite as

Wiow = k1B, (Cooper and Alley, 2011, pp389) (2)

Equilibrium adsorptivity or capacity W represents the maximum amount of adsorbate
the adsorbent can hold at a given temperature and partial pressure. However, in prac-
tice, the activated carbon filter lost its function as it reaches the saturation stage. Acti-
vated carbon filters are then replaced before they reach equilibrium. Thus, the actual
capacity, or working capacity of activated carbon system is smaller than the theoretical
equilibrium capacity. Working capacities can range from 10 - 70% of the equilibrium
capacity (Wang, Pereira and Hung, 2004, pp396-397; Theodore, 2008, pp196). In other

word, the equilibrium capacity also indicates the life time of activated carbon filters.

However, calculating the adsorption equilibrium and life time of activated carbon filter is
not the focus of this study since every set of test on the filters were replaced by a fresh
one. This report will focus more on the experimental work of testing the removal effi-

ciency of toluene with designed conditions.

3.5 Gas chromatograph mass selective detector

Gas chromatography (GC) is one type of chromatographic analysing method dealing
with gases or vaporized substances. GC can be used for identifying different compo-
nents of a mixture by separation. As explained by Agilent Technologies (2002, pp10),
“GC creates a time separation rather than normal physical separation such as filtration
and distillation.” GC allows the analysing vaporized mixture of gaseous sample to be
separated in time when pass through the tube which contains a material that retards
some components more than others. The detected result shown on a computer is a
plot of chromatogram. Each peaks with their corresponding retention time on the chro-
matogram represent different components of the original mixture. The retention time of
each component is distinctive and thus can be used to identify each component. The
peak size (area) measures the amount of the component and can be later calculated

into concentration for example. (AT, 2002, pp10)
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The basic system of a GC system consists the source of carrier gases, an injection
port, a column, a detector, and a corresponding data interpretation program on a com-
puter. The flow chart of a GC is shown as in Figure 4. In this thesis, the carrier gas is
helium, the injection port is thermal desorber, the GC is capillary column, and the de-

tector is mass selective detector.

Sample

:

Gas source [ Inlet —  Column —  Detector [ Data reduction

Figure 4. Flow chart of a gas chromatography system (AT, 2002, pp11).

GC works on the procedure of that the analysing sample is first injected and vaporized
at the injection port and then being transported by carrier gas to the column. The sam-
ple is heated up at a very high temperature inside the column. Part of the sample may
already evaporates to the surrounding at this point. As it continues its path by the carri-
er gas, it reaches the detector. The detector will then detect the left over sample where
the data is transmitted and displayed on a computer. After being detected, the rest of
the sample will evaporate through the escaping hole to the surrounding.

3.5.1 Carrier gas and tubing

In GC, gaseous sample is transported through the tubing in the column by a gaseous
mobile phase which is known as the carrier gas. Carrier gas must be supplied along
the gas lines into the GC in order to transport analysing samples throughout the ana-
lysing process. The most common carrier gas is helium which is compatible with most
GC system. According to Harris (2010, pp575), “Gas flow through a narrow column
may be too low for best detector performance, so extra makeup gas is sometimes add-
ed between the column and the detector. Makeup gas that is optimum for detection can

be a different gas from that used in the column.”

In this thesis, helium gas and air gas tanks were used as the carrier gas and extra

makeup gas respectively for the GC system.
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3.5.2 Injection port

Inject port introduces and vaporizes the sample into the carrier gas stream along the
pipe line. The choice of injection port depends on the type of column (capillary or
packed, which are described in the next section) being used. Packed column uses
packed port while capillary column uses split/splitless port.

Split/splitless port has two operating mode, split and splitless. Due to the property of
capillary column which has very small capacity for samples, sample injected to column
must avoid overloading it. Handling such small sample size is usually difficult. As a
result, the split mode which transfers only part of the sample to the column, is used
control and provide small enough sample. The rest of the sample is vented to waste.
Split mode is used also when one wants to keep the sample, due to, for example the
difficulty of preparing the same sample, and the residual part is not being vented to
waste. This can be done when using a tenax tube, which will be discussed in the later
section. For splitless mode, it is well suited with low concentration samples, so that the
sample amount does not need to be reduced. (AT, 2002, ppl17-22) Figure 5 below illus-

trates the port in splitless mode.

Inlet Septum
flow Septum nut purge
control with septum control
Ho= e
AR
- =
Liner. Split Split
valve vent
(closed) control

Figure 5. Split/splitless port in spitless mode (AT, 2002, pp21).

The split valve in Figure 5 can be managed by computer program in which closing the

valve for splitless mode and opening the valve for split mode.
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3.5.3 Column

There are several types of columns, such as capillary and packed columns, which are
selected for different performance. However, they all work on the similar principle. Typ-

ical column is shown in Figure 6.

Carrier
gasin
Silicone
rubber ’ lpl,
septum A
p \ i|— _Jl 'Illl_} L
~ ] — Exit
Injector | C
omputer
port Injector Detector
oven
Detector
oven
- Column
Column oven

Figure 6. Schematic diagram of a gas chromatograph column (Harris, 2010, pp566).

The sample separation is carried out in the column as the column oven is heated to
around 300 °C to obtain the gaseous sample in mobile phase. The coating on the inner
surface of column diffuses the components of the gaseous sample as they were carried
by the carrier gas. Different types of coating have different characterises. These diffus-
ing forces can be “solubility, volatility, polarity, specific chemical interaction, or any oth-
er property that differs from one component to another” (AT, 2010, pp29). The compo-
nent easily attracted by the coating will move slower than those invulnerable ones. As a
result, different components are separated by their speed which is then detected as in
different retention time. (AT, 2002, pp28-29)

The length of column can be up to 100 m where the common length is around 30 m.
(Harris, 2010, pp567) Such long pathway allows the sample to be heated evenly with
sufficient time. In order to reduce volume and ease the heating, the column piping is
looped in a circle around a frame as shown in Figure 7 below. The inner diameters of

columns are typically between 0.10 and 0.53 mm. According to Harris (2010, pp567),
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“Narrow columns provide higher resolution than wider columns but require higher oper-
ating pressure and have less sample capacity.” The difference in thickness and length
will alter the retention time. The retention time increases as the thickness is increased
or the length is reduces. (Harris, 2010, pp566-567)

Figure 7. Fused silica capillary gas chromatography column (Dot red, n.d.).

A capillary column, also known as open tubular columns can finely separate complex
samples by providing very narrow peaks. In general, capillary column performs better
than packed columns as they can deal with various conditions and separate samples in
more detailed and need only a small amount of samples. The more narrow the peaks,
the better the efficiency. (AT, 2002, pp30) However, when dealing with large amount of

gas sample, a packed column could be more suitable (AT, 2002, pp35).

3.5.4 Detector

There are several types of detectors including thermal conductivity, flame ionization,
electron capture, and mass selected detector. Detector analyses the individual compo-
nents which has been diffused from column. Detected components are compared with
the detector’s spectra library (Harris, 2010, pp579). Thus, each component can be
identified and the data are collected in the computer program. Mass selected detector
(MSD), also called mass spectrometry, is a sensitive detector that provides both quanti-
tative and qualitative information of the detecting samples. MSD can detect even very
small amount of samples in ppb and ppt level with detailed narrow peaks. (Harris,
2010, pp582-584)
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3.6 Tenax tube

Tenax tube is also known as thermal desorption sorbent tube as it is a matching part to
the thermal desorber. It works as a media to store and transport the sample which can
be later inserted into the injection port of thermal desorber. Tenax tube is shown in Fig-
ure 8 below. The left side of the tenax tube that has a ring of groove as shown in Figure
8 is the head while the right side is the tail. Tenax tubes look the same which can be
confusing when recording the data, however their identical numerical coding help to
distinguish them from each other.

Figure 8. Tenax TA tubes manufactured from Marke International. Each tubes are labeled with numerical
code. The side with a ring of groove is the head of the tenax tube.

Tenax tube has adsorbent inside which can trap volatiles and semi-volatiles from air or
water. Tenax TA is the type of tenax tube used in this study. According to SIS (n.d.),
“tenax TA is a porous polymer resin based on 2.6-duphenylene oxide”. Tenax TA is a
good trapping agent with very low level of impurity. More information can be found in

Appendix C.
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4 Methodology

In order to analyze the behavior of activated carbon filters on removing toluene pollu-
tant, a system was created to demonstrate this indoor air purifying process. A model
was designed and built to carry out this approach. Activated carbon filters with one, two,
and three layers were made and installed and tested in the model individually. Tenax
TA tubes were used to take samples from the model. The samples were then analyzed
by TD-GCMSD. To decide the parameters for operating the system, pre-work was car-

ried out with several trails.

The activated carbon type used is impregnated activated carbon (IAC) with PUR sub-
strate (See Appendix B). Thermal desorber gas chromatography mass selective detec-
tor (TD-GCMSD) was used for analyzing the toluene samples collected by the tenax
tubes. Capillary column was used for the GC. The injection port was thermal desorber
and the detector is the mass selective detector. The model of GC system used in this
study is HP 6890 series combined with a MSD HP 5973. The model of thermal desorb-
er used is UNITY (serial No. GBO0U10282) manufactured from Markes International.
The TD-GCMSD device used is shown in Figure 9 below.

Figure 9. TD-GCMSD.
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The analyzing program installed in the computer is MSD ChemStation (version
G1701DA D.01.02.16 15-JUNE-2004) from Agilent Technologies and Thermal Desorp-
tion System Control program (TDSC program) (version 2.0.0) from Markes Internation-
al. TDSC program is used to control the thermal desorber while MSD ChemStation is
used to operate the GCMSD. The instructions for using TD-GCMSD and these two
programs to analyse and clean the tenax tube are explained in detailed in Appendix F
and G.
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5 Experimental work

5.1 System and model

As described, the purpose of this experimental work was to test the activated carbon
filter behavior on removing toluene pollutant in the air stream. The system was de-
signed to demonstrate such approach. The model is shown in Figure 10. More pictures
can be found in Appendix D.

Figure 10. Experimental system and model.

The model was constructed with PVC pipes having an inner diameter of 10 cm. The
model was built in a U-shape due the size of the available fume cupboard. The pipe
line needed to be long enough to enable the airflow being mixed and stabilized. Two
mixers were fixed inside the pipe line before and after the U-turn to help stabilizing the
airstream. An airflow meter was attached to the other end of the pipe. Airflow meter
was used to measure the air speed in order to adjust the fan. Every joints and openings
of the pipe system were fixed and sealed by duct tape. To eliminate possible second-
ary toluene pollutant from duct tape, parafilm was used to wrap the joints and cover the
openings before taping.
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Toluene gas was prepared and fed into the pipe model through silicon tube. Toluene
(Riedel-de Haen, min. 99.7%) was placed in a measuring cylinder which was coupled
with a Dreschel bottle head as shown in Figure 11. By using the silicon tubes, one end
of the gas bubbler was connected to nitrogen gas tank and the other end to the pipe
model. Nitrogen gas generated toluene being bubbled and vaporized. The flow of the
nitrogen was controlled by a flow meter (see Appendix D). A small magnet was placed
in the measuring cylinder to help evaporate toluene evenly with the use of a plate stir-

rer.

Figure 11. Measuring cylinder coupled with Dreschel bottle head (sinter porosity grade 0) (Dreschel bottle
heads, camlab, n.d.).

IAC filters were assembled at the top layer of the pipe system. IAC provided from
Genano has a thickness of 2 cm (see Appendix B). These IAC were first cut into circles
with diameter of 10 cm which can fit inside PVC pipes. Additional PVC pipes were cut
into three cylinders with desired length of 7.5 cm, 11.5 cm, and 13.5 cm. IAC filters
were made by fitting IAC into these PVC cylinders. Three IAC filters were made having
one layer, two layers, and three layers of IAC of each. IAC were fixed inside the PVC
pipes by PVC joint pipes as shown in Figure 12. These filters could be easily removed
and displaced during the experiment. New parafiim and duct tape were always used

when replacing a new filter.
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(2.5 cm)) '
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Figure 12. IAC filters with one layer and two layers. IAC (black part) is placed in between two PVC pipe
joints when fit into the corresponding PVC cylinders. One-layer and two-layer IAC filter have length of 7.5
cm and 9.5 cm. Three-layer IAC filter has a length of 11.5 cm.

Two openings were drilled before and after the filter section on the pipe for tenax tubes
to take air samples. Samples taken from the opening before the filter on the right side
is the inlet flow (IN). Samples taken from the opening after the filter on the left side is
the outlet flow (OUT). These two openings were drilled to have the size that fits the
tenax tube which is covered with silicon tube. These two openings were sealed with
parafilm and duct tape.

The tenax tubes used are the TA type. They collect samples with the help of a pump
for extracting air volume inside the pipe model as shown in Figure 13.

Figure 13. Tenax tube and pump. Silicon tube at the head is 6 cm long which enables it to reach the center
point of the airstream in the pipe when inserting it into the opening for taking samples. (The length of the
head part of tenax tube is 1 cm, and the radius of the pipe is 5 cm.).
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The efficiency of the pump is 113 mL/min. The pump is connected by a silicon tube
attaching to the tail of tenax tube. The head part of tenax tube is also connected to an-
other silicon tube. This silicon tube provides an air tight function and is the part being
inserted into the openings when taking samples. Moreover, samples must be taken at
the center point of the airstream inside the tube. Therefore, silicon tube connected at
the head must have a desirable length. After the sample was taken, the tenax tube was
immediately sealed with the silicon caps on both ends and stored in ziploc bags before

inserting to the TD for analysis.

5.2 Pre-work

In order to decide the parameters on preparing toluene fed into the pipe model (at in-
flow) which was desired to be small enough in the unit of ppm, several pre-works were
conducted based on the result from TD-GCMSD analysis. These parameters included

the nitrogen gas flow rate and the pumping time when taking sample by tenax tube.

Pre-work was carried out with changing in nitrogen gas flow rate and the pumping time.
The filter used in the pre-work was one layer while the speed of fan which was kept
constant with 1 m/s at all time. Samples were only taken at the inflow opening by the
tenax tubes. Pre-work started with the smallest possible nitrogen gas flow which was
10 mL/min and increased up to 100 mL/min. The pumping time was tested from 1 min
up to 10 min. After several rounds of trials, nitrogen gas flow rate and pumping time
were concluded to be reasonable with 100 mL/min and 5 min respectively (see Appen-
dix E). With this setting, the result shown roughly few ppm of toluene at the inflow be-
fore contacting the filter.

5.3 Experiment

Based on the result from pre-work, toluene was prepared with nitrogen flow of 100
mL/min and feed into the pipe model. Figure 14 below illustrates the conceptual sche-
ma of the model. The vaporized toluene was prepared by using nitrogen gas mixed

with toluene liquid in a Dreschel bottle as explain in previous section.
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Figure 14. lllustration of the pipe model.

There were two different batch of IACs, September and October. These IACs were
made into different layers of AC filters, as in one, two, and three layers. Each AC filter
was tested separately. After installing an AC filter, nitrogen gas tank was opened, tolu-
ene vapor was feed in, fan was controlled to 1 m/s, the sampling openings were
sealed, and the system was kept running for about an hour to stabilize. When one AC
filter finished the test, another AC filter was replaced and carried out the same proce-
dure. Due to the pressure drop caused by having more layers of AC filters, the power
of the fan must be adjusted or increased to keep the reading on the air speed meter to
be 1 m/s at all time. As a result, the system could be carried out in the same condition.

Three replicates were taken from both IN and OUT individually by the tenax tube for
each AC filter. They were taken in the order of first one IN, second one OUT, third one
IN, fourth on OUT, and so on. The opening was covered immediately after taking the
sample by tenax tube. The time intervals between each sampling taking were less than
2 min. After the sample was taken, the tenax tube was immediately sealed with the
silicon caps on both ends and stored in ziploc bags before inserting to the TD for anal-
ysis. Tenax tubes’ numerical codes were recorded down to distinguish from each other

and eased the data collecting.

There were two batches having three AC filters and three replicates were taken for
both IN and OUT. Therefore, 18 samples (tenax tubes) were taken in one set of exper-
iment. And testing both batches would need a total of 36 samples.
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5.4 Analysis

Tenax tubes were analyzed based on the instruction in Appendix F. After tenax tube

was been analyzed, it is regenerated or cleaned by the TD (see Appendix G).

The data were collected and recorded by using Microsoft Excel sheet. The areas from
the GC graph were interpreted into unit of ppm. The unit conversion was calculated by

using an online converter from Markes International (n.d.).
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The result for batch September (AC 1-3) was shown in Table 5 below (Experiment

were carried out in the condition of N2: 100 mL/min; fan: 1 m/s; pump time: 5 min; sam-

ple volume: 0.565 L). Three replicates were taken for each position of each AC filters

and the average value were calculated and listed in the Table 5. More detailed data

were recorded in Appendix I.

Table 5. Batch Sep. AC1-3 results (N2: 100 mL/min; fan: 1 m/s; pump time: 5 min; sample volume: 0.565

L).

AC position | average GC | average average concentration | average

layer area mass (ug) (mg/m?) ppm

AC1 |IN 1017129356 | 12.48 22.10 5.84
ouT 610021062 | 7.49 13.25 3.45

AC2 |IN 872315110 | 10.71 18.95 4.78
ouT 674139293 | 8.27 14.65 3.71

AC3 IN 825547438 | 10.13 17.93 4.51
ouT 901935102 | 11.07 19.59 5.04

Based on this result, the removal efficiency of IAC filter (batch Sep.) could be calculat-

ed.

Therefore,

Efficiency (AC1, batch Sep.) = 40%
Efficiency (AC2, batch Sep.) = 22.7%
Efficiency (AC3, batch Sep.) =-9.3%

ef ficiency =1 —

concentration(OUT)

concentration(IN)

(3)

The initial expectation was that the more AC filters, the better the removal efficiency.

Surprisingly, this results showed that the more AC filters, the less the efficiency. How-

ever, the 40% removal efficiency shown a reasonable result which was similar to the

Genano Oy Company’s test.

Batch November was carried out following the same parameters and procedures.

However, the results were incomprehensible where the concentrations of toluene at
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OUT and IN were similar. Therefore, it was not appropriate to carry out the data analy-

sis. More details could be found in Appendix J.

Due to the possible technical problem with the TD-GCMSD, personnel (Jussi Erkkil&)

from Genano brought and used their own tenax tube to take few samples from the

batch October. The result is shown in the table 6 below (also see Appendix K).

Table 6. Batch October AC2 result from Genanoy Oy Company.

AC layer | position | concentration (ug/m?) | ppm
AC 2 IN 1550 4.78
1760 5.43

1963 6.06

ouT 1160 3.58

1580 4.88

1790 5.52

Regarding the result from Genano Oy Company, batch October AC2 had an efficiency

of 14.1 % on removal of toluene.
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7 Discussion

The results from the TD-GCMSD throughout the experiment were inconclusive. After
several test, the reliability of the devices were being doubted. Several attempts were

made to solve the problem. However, they were not very effective.

All the device used were the best available from Leiritie campus. However, they were
more than ten years old, and some were even twenty years old. Therefore, there could
be possible experimental errors. TD-GCMSD was broken down during the experiment
and technicians came to fix it. And this happened several times throughout the experi-

ment. The trap and the ring in TD were too old.

Regarding tenax tubes, they have a life time of 100 times usage which means they
could be used around 5 to 10 years. In addition, tenax TA tubes might not be the most
suitable type of tenax tube for this study. However, these tenax TA tubes were the only
available ones which were purchased more than ten years ago. Therefore, the test on
the quality of tenax tubes was carried out by analyzing the empty tenax tubes after be-
ing cleaned by TD. The tenax tube should be empty inside and show no plot in GC
graph after being cleaned. However, several tubes showed very poor results with high
noises and contamination. These tenax tubes were then separated according to the
GC graph in to broken tubes and usable tubes. The broken tubes were ready to be
thrown away. Appendix H describes the criteria | made and also shows a list of usable
tubes and bad tubes. The experiment was then carried out by using these usable

tubes.

To improve this study, new TD and tenax tubes would be needed. Also, some modifica-

tion on the pipe model could be set to eliminate any possible leaking.
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8 Conclusion

It was unfortunate that the experiment could not be carried out according to the initial
expectation. The results were inconclusive. However, if the devices were reliable, and
the results were actually correct, it might be suggested that the more layers of AC filter
or the thicker the AC filter, the less effective of the toluene removal. But | believe this

could not be true.

Despite the irrelevant results, activated carbon filter showed its ability on removing
VOCs like toluene vapor. And this pipe model was successful in preparing toluene va-

por in low concentration.

Further research could be conducted on improving the system by using non-PVC pipes
and eliminating all possible leaking at the joints and openings. Instead of tenax TA
tubes, other types of tenax tubes could be examined.
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Appendix A. MSDS for toluene (Sigma-Aldrich)

Full text of H-Statements referred to under sections 2 and 3.

Asp. Tox. Aspiration hazard

Flam. Lig. Flammable liquids

H225 Highly flammable liquid and vapour.

H304 May be fatal if swallowed and enters airways.

H315 Causes skin irritation.

H336 May cause drowsiness or dizziness.

H361d Suspected of damaging the unborn child.

H373 May cause damage to organs through prolonged or repeated exposure.
Repr. Reproductive toxicity

SKin Irrit. Skin irritation

STOT RE Specific target organ toxicity - repeated exposure

Full text of R-phrases referred to under sections 2 and 3

F Highly flammable

Xn Harmful

R11 Highly flammable.

R38 Irritating to skin.

R48/20 Harmful: danger of serious damage to health by prolonged exposure through

inhalation.

R63 Possible risk of harm to the unborn child.

R65 Harmful: may cause lung damage if swallowed.

R67 Vapours may cause drowsiness and dizziness.

Repr.Cat.3 Toxic to Reproduction Category 3

Precautionary statement(s)

P210 Keep away from heat, hot surfaces, sparks, open flames and other

ignition sources. No smoking.

P261 Avoid breathing vapours.

P281 Use personal protective equipment as required.

P301 + P310 IF SWALLOWED: Immediately call a POISON CENTER or doctor/

physician.

P331 Do NOT induce vomiting.

Information on toxicological effects

Acute toxicity

LD50 Oral - Rat - > 5.580 mg/kg

LC50 Inhalation - Rat - 4 h - 12.500 - 28.800 mg/m3

LD50 Dermal - Rabbit - 12.196 mg/kg

Skin corrosion/irritation

Skin - Rabbit

Result: Skin irritation - 24 h

Serious eye damage/eye irritation

Eyes - Rabbit

Result: No eye irritation

(OECD Test Guideline 405)
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Appendix B. Impregnated activated carbon filter data

Appendix 2
1(1)

The information of IAC filter from Genano Oy Company. IAC filters used in this thesis

were not necessary the filters from Genano Oy Company.

G

GeNono

Description:

Carrier material:

Carbon:

Pressure drop:

Fire retardation:

Special remarks:

Temperature resistance:

Technical Data Sheet for Carbon Filter Media

Activated carbonimpregnated sorption media on PUR substrate

PUR Foam open celled:

Density:

Foam Density:
Nominal thickness:
Binder:

Binder content:
Carbon add-on (%):

Powder Carbon type:
Based on:

H20 content:

Ashes content:
pH-value:
Molasses-factor:
Net carbon quantity:
Internal surface:
lodine adsorption:
Methylbluetiter:
Grounfineness:

at 1,0 m/s

Operating Temperature:

PPI 20
120 kg/m3
30 kg/m3

20 mm £ 1 mm
copolymer of vinyl acetate and ethylene

10 %
300%

Carbopal SC 44-1
coconut shell

<10 %

<7%

9-11

22+0,2

1800 g/m?

1 000 m?/g (BET method)
950 mg/g

12 ml

75 (weight-%) < 40 micro-m

25 Pa
100 (120) °C

F 1 (DIN 53438)

below 50 °C

Genano Ltd » Kimmeltie 3, 02110 Espoo, Finland » +358 9 774 2870 « info@genano.com » VAT number FI21752180 « www.genano.com
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Appendix C. Tenax TA tube details

Sourced from SIS and Markes International.

Properties

e Chemical Structure or Name: 2,6-diphenylene-oxide polymer resin
* Temperature Limit: 350 °C

¢ Affinity for Water: low

» Specific Surface Area: 35 sq. m/g

* Pore Volume: 2.4 cc/g

* Average Pore Size: 200 nm

* Density: 0.25 g/cc

* Mesh size: 60/80 mesh

¢ Other mesh sizes available on special request

Major Areas of Application

¢ Purge and Trap of Volatiles from Water

* Trapping Volatiales from Environmental Air

* Trapping of Volatiles from Human Breath

¢ Trapping Flavors and Frangrances from Plants and Commercial Products
* Trapping of Volatiles from Soil (PNA's and PCB's)

* Personal Exposure Monitoring

8.1.2 Tenax TA or GR (range of mesh sizes available)

Sorbent Strength: Weak
Specific Surface Area (m2/g): »35
Approximate analyte volatility range: n-C7 to n-C30
Bpt. 100°C to 450°C
Example Analytes: Aromatic compounds (except benzene), apolar

components boiling point >100°C, polar components
boiling point >150°C, PAHs and PCBs.

Sorbent Maximum Temperature: 350°C
Recommended Conditioning Temperature: 325°C
Recommended Desorption Temperature: Up to 300°C

Notes: . Hydrophobic, low inherent artifacts (< 1ng), inert, graphitised
form best for PAHs and PCBs, efficient desorption, use 35-
60 mesh to minimise fines and eliminate "leakage" through
conventional sorbent retaining gauzes
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Appendix D. Experimental work model for toluene removal by IAC filter

Some more photo for the system model.

Air speed meter used to control the fan.

Air flow meter used to control the nitrogen gas flow. (Model: Brooks Instrument Delta
Smart Il Mass Flow (left) and Brooks Instrument 0254 (right).)
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Appendix E. Pre-work result

¢ Condition: AC 1 layer, fan 1 m/s, stabilized for 1 hr.
o Sampling postion IN for the first table.

* GC graph for toluene was calibrated by Patrik Paul where

1 unit area = (430.31/35057368443) ug

Appendix 5

1 (1)

N2 flow pump | tenax # pumping GCMSD mass (ug) ppm
(mL/min) | time volume (L) | area

(min)
10 1 059783 0,113 35823552 0,439714484 0,8

1,1 059764 0,1243 - - -

1 058988 0,113 27945460 0,343015218 0,8

2 058986 0,226 12088827 0,148383732 0

2 059093 0,226 33194935 0,407449649 0,27

2 058984 0,226 189769096 | 2,329311735 0,65
20 1 059761 0,113 2637004 0,03236778 0

1 059763 0,113 - - -

1 058983 0,113 17115690 0,210085722 0,27

2 034850 (?) 0,226 - - -

2 034842 0,226 4691815 0,05758946 0

2 034843 0,226 5936557 0,072867986 0

3 059770 0,339 - - -

3 059785 0,339 7838430 0,096212436 0

3 059786 0,339 9333573 0,114564497 0
50 1 059764 0,113 - - -

1 059093 0,113 29157789 0,357895893 0,8

1 058986 0,113 7681740 0,094289152 0

2 058984 0,226 122901648 | 1,508550427 1,59

2 034842 0,226 15363745 0,188581557 0

2 059763 0,226 15655576 0,192163622 0

3 034849 0,339 27931513 0,342844027 0,27

3 059761 0,339 23003212 0,282351831 0

3 034850 0,339 31828403 0,390676217 0,27

5 059782 0,565 30868862 0,378898377 0

5 030481 0,565 29578511 0,363060025 0

5 034843 0,565 50474426 0,619545939 0,27

10 058983 1,13 132154160 | 1,622119946 0,27

10 058982 1,13 353299701 | 4,336560361 0,8

10 059768 1,13 173519318 | 2,129854608 0,27
N2 position | tenax# | pumping GCMSD mass (Ug) ppm
flow: volume (L) area
100 IN 059783 | 0,565 281319479 | 3,453042552 1,59
mL/min | IN 059785 | 0,565 461292244 | 5,662109689 2,65

IN 059786 | 0,565 550234538 | 6,753827642 2,92
pump ouT 059761 | 0,565 364542329 | 4,474557463 1,86
time:5 [ QuT 059762 | 0,565 457222191 | 5,612152017 2,39
min ouT 059765 | 0,565 539135842 | 6,617597226 2,92

* AC 1 layer filter had been placed there for more than half year, so as expected that the result
between IN and OUT were similar. However, 5 min pumping time shown the most stable resul
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Appendix F. Instruction for tenax tube analysis

MSD ChemsStation (version G1701DA D.01.02.16 15-JUNE-2004) from Agilent Tech-
nologies and Thermal Desorption System Control program (TDSC program) (version
2.0.0) from Markes International were used. “Unit” program refers to the TDSC pro-

gram.

switch on the thermal desorber device

open program “Unity”

click [File] -> [Open] -> [Splitless Tenax tube desorption.mth] -> [open]

click [File] -> [Load] (Standard 2(3))

Check air tank, open it.

Check Inlets and change to back and GasSaver off

go to program “Instrument #1” and click the green arrow

change the “Data File Name” to the tenax tube number for testing and

write down Misc.Info if needed, and press [start run] and [0K]

9. put the tenax tube into the thermal desorber device

10. go to program “Unity” and press the run bottom and ok and wait about
45 minutes

11. when the test is ready, go to program “Instrument #1” and click [View] ->
[Data Analysis (offline)]

12. when it change to a new window (Enhanced Data Analysis), click [File] -
> [Load Data File] and then select the tenax tube and click ok

13. then click [Spectrum] -> [Select Library] -> [Browse] -> [NBS75K.L] and
click ok

14. click [Chromatogram] -> Autolntegrate

15. click [Spectrum] -> [Library Search Report] and choose only [on screen]
and press ok to check the retention time for toluene

16. then click [Chromatogram] -> [Percent Report] to find the area of toluene

ONOORWNE
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Appendix G. Instruction for tenax tube cleaning
MSD ChemStation (version G1701DA D.01.02.16 15-JUNE-2004) from Agilent Tech-

nologies and Thermal Desorption System Control program (TDSC program) (version
2.0.0) from Markes International were used. “Unit” program refers to the TDSC prog-

ram.

1. switch on the thermal desorber device

2. open program “Unity”

3. click [File] -> [Open] -> [Tenax condition.mth] -> [open]

4. settime to 10 min and temperature to 300 and flow path temp to 180.

5. click [File] -> [Load]

6. putthe tenax tube into the thermal desorber device

7. go to program “Unity” and press the run bottom and ok and wait about 20
minutes
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Appendix H. List of good and bad tenax tube from empty tube testing

Clean (empty) tenax TA tubes were tested and the result were shown in the table be-

low. The usable (Good) tubes were the tubes which had a noises or contaminates low-
er than 1000000 unit of the GC graph. And the bad ones were those above that

amount. There were all together thirty-one tenax TA tubes available in Leiritie campus.

Based on this parameter, 18 were usable and the rest 13 were said to be ready to be

thrown away.

Good (noises or contaminate < 1000000) ;
030481 058982
030482 058983
030486 058984
030590 058985
034842 058986
034843 058987
034845 058988
034849 058989
034850 059093
059761 059764
059762 059767
059763 059782
059765 059783
059768
059770
059785
059786
059790

y ==
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Appendix |. Batch September AC1-3 result

Appendix 9
1(1)

Experiment were carried out in the condition of N2: 100 mL/min; fan: 1 m/s; pump time:

5 min; sample volume: 0.565 L; stabilization time (between each AC filters): 1 hour.

position | tenax # | GC area mass (ug)
Iayer

AC1

AC2

AC3

ouT

ouT

ouT

058989
059764
059765
059786
059783
059767

030590
059782
059768
059763
059762
059785

059761
058984
059790
034843
034849
034850

1074451901
1081571160
895365006
555816174
683138011
591109000

905938280
834695461
876311588
542436736
678374971
801606172

793712314
861785018
821144981
620580062
918448408
1166776835

13.18830871
13.27569371
10.99011514
6.822339167
8.385144994
7.25553928

11.11989629
10.2454297

10.75624487
6.658113893
8.326681287
9.839276797

9.742384012
10.57793918
10.07910498
7.617280427
11.27345126
14.32154672

concentration
(mg/m?3)
23.34213931
23.49680303
19.45153122
12.07493658
14.84096459
12.84166244

19.68123237
18.13350389
19.03760154
11.78427238
14.737489
17.4146492

17.24315754
18.72201624
17.83912385
13.48191226
19.95301108
25.34787029

6.10
6.10
5.04
3.18
3.71
3.18

5.04
4.78
5.04
2.92
3.71
4.51

4.51
4.78
4.51
3.45
5.04
6.63
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Appendix J. Batch October AC1-3 result

Experiment were carried out in the condition of N2: 100 mL/min; fan: 1 m/s; pump time:

5 min; sample volume: 0.565 L; stabilization time (between each AC filters): 1 hour.

position | tenax # | GC area mass (ug) concentration | ppm
layer (mg/m?3)

AC1 059761 731203212 8.975119016 15.8851664 3.98
034845 | 922051219 @ 11.31767379 20.03128105 531
030482 1051520472 12.90683797 22.84396102 5.84
ouT 034843 655836149 @ 8.050029589 14.24783998 3.71
059785 971377330  11.92312479 21.10287574 5.57
030482 | 1070380885  13.13833922 23.25369773 6.1

AC2 IN 059763 | 1037494256 12.73467385 22.53924576 5.84
059765 1169730606 14.35780264 25.41204007 6.63
030486 @ 1267535946 15.55830963 27.5368312 7.16
ouT 059790 1160820623 14.24843747 25.21847341 6.63
059786 @ 1066322532 13.08852516 23.16553125 6.1
059768 1101371560 13.51873278 23.92696067 6.1

AC3 IN 034850 1006658262 12.35617891 21.86934321 5.57
030481 924176874 | 11.34376504 20.07746025 531

059762 1306934177 16.04190134 28.39274573 7.43

ouT 034842 | 810339988 | 9.946479605 17.60438868 451

030590 870102256  10.68002872 18.9027057 4.78

059770 | 1183796943 | 14.53045922 25.71762694 6.63
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Appendix K. Batch October AC 2 layer result from Genano Oy Company

C) MetropoliLab

TESTAUSSELOSTE 2015-26637

1(1)
04.12.2015

Tilagja Maksaja
2175218-0
Genano Oy Genano Oy Ab
Erkkila Jussi Laskutus
Kimmeltie 3 Niinisténkatu 8 s oo
02110 ESPOO 05800 HYVINKAA
Naytetiedot Nayte Sisdilma VOC
Nayte otettu 25.11.2015 Kellonaika
Vastaanotettu 26.11.2015 Kellonaika 09.45
Tutkimus alkoi 26.11.2015 Naytteenoton Tilaustutkimus
syy
Naytteen ottaja Erkkila Jussi
Viite Testi/Genano
Tolueenin pitoisuudet:
1) 1550 ug/m3
2) 1160 ug/m3
3) 1760 ug/m3
4) 1580 ug/m3
5) 1963 ug/m3
6) 1790 ug/m3
Analyysi| TVOC tolueenina (TD-GC-MSD/FID)
Yksikk6 | pg/m?
Menetelma | ISO 16000-6:2011
Epévarmuus-% | 30
Nayte ¥
26637-1, Sisdilma VOC, in 1, genano X
26637-2, Sisdilma VOC, out 1, genano X
26637-3, Sisdilma VOC, in 2, genano X
26637-4, Sisdilma VOC, out 2, genano X
26637-5, Sisdilma VOC, in 3, genano X
26637-6, Sisdilma VOC, out 3, genano X
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Lukkarinen Timo, 010 3913 431, Kemisti

JT It

Kalso Seija
toimitusjohtaja

Erkkila Jussi, jussi.erkkila@genano.fi

Akkreditointi ei koske lausuntoa. Analyysitulokset patevat ainoastaan analysoiduille naytteille.
Analyysitodistuksen saa kopioida vain kokonaan. Muussa tapauk

kopioinnista on saatava lupa.

Postiosoite
Viikinkaari 4
00790 Helsinki

metropolilab@metropolilab.fi

Puhelin
+358 10 391 350

http:/AMww.m etropolilab.fi

Faksi
+358 9 310 31626

Y-tunnus
2340056-8
Alv. Nro
FI23400568

|

Helsinki

Metropolia

University of Applied Sciences



